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Excel Basics
In this chapter you will learn:
• How to enter information into a worksheet
• How to use formulas more extensively
• How to manipulate data and structure worksheets
• How to print a worksheet

Case: What SUP, Inc.
After providing you a tour of Excel, Kyle suggests you all practice entering
information into Excel using some formulas, functions, and features that are
common to almost all accounting applications. He has created a preliminary
trial balance for you to work on.

Video Demonstration

DEMO 2A Entering
information into a work

Entering Information
To complete the trial balance it will be necessary to enter additional text and
numbers. The basic data entry container for Excel is a cell. Each cell has an
address determined by its location on the worksheet grid. The column number
and row number determine the address.

Entering Data
Kyle explains that, before putting data into a cell, you must first select the cell
by clicking on it. As you type, the data is also automatically entered into the
formula bar. Text entries into cells are often referred to as labels, whereas numbers or formula entries are referred to as values.

To open the trial balance file and enter data into the
worksheet:
1 Start Excel and then click Open Other Workbooks.
2 Double-click Computer and then double-click Browse. Navigate the
Open window to the location of this text’s student files. (The location
would be the CD provided with the text or from your computer lab’s
server.)
24
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3 Double-click the file ch2-01, which should be located in a Ch 02 folder.
The workbook shown in Figure 2.1 should appear.

Figure 2.1
Partially Completed Trial Balance

4 Click cell B7, type 84245.25, then press the [Enter] key. Note how the
number is automatically formatted for you (more on this later). Note
also that the active cell is now one row lower, at cell B8.
5 Type 125351.45 in cell B8, and then press the [Enter] key.
6 Click cell C20, type 1527515.65, then press the [Enter] key. Note that
the cell value may show several # signs. If this happens, you will need
to resize the column width (more about this later).
7 Click cell A26, type the label Total, then press the [Enter] key. We’ll
format this cell later.
8 Continue to fill in the remaining empty cells so that your worksheet
looks like that shown in Figure 2.2.
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Figure 2.2
Almost Completed
Trial Balance

You have thus entered both values and labels into your worksheet. Now you
can make changes to the data already entered.

Changing Column Width and Row Height
Perhaps now is a good time to fix that sales number on the trial balance as Kyle
suggests. The problem occurred when a number entered in cell C20 was wider
than the column permitted. The result was a cell filled with # signs. To fix it,
Kyle explains, all you have to do is resize column C. However, for uniformity,
you should resize not only column C but also column B.

To change the column width and row height of a worksheet:
1 Place the mouse pointer between column C and column D at the top of
the columns so that the mouse pointer cursor changes into a line with
two arrows pointing left and right.
2 Double-click the mouse. Then click and hold the mouse button down to
reveal the new column width as being Width: 11.38 (96 pixels).
3 To resize both column B and C point the mouse pointer to the B of column B and click once. (This selects the entire column B.)
4 Now click and drag from the B of column B to the C of column C.
(This selects both columns B and C.)
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5 With both columns selected, place the mouse pointer between column B
and column C at the top of the columns so that the mouse pointer cursor changes into a line with two arrows pointing left and right.
6 Click and drag the column width to the right until the width is 13.00
(109 pixels). Both columns should now be the same width 13.00 (109
pixels).
7 To resize the height of row 4, click between rows 4 and 5 at the far left
of the worksheet until the mouse pointer cursor changes into a line with
two arrows pointing up and down.
8 While still holding the mouse button down, drag the row height down
until the height is 21.00 (28 pixels).

‘‘If you are like me,’’ Kyle admits, ‘‘you will find yourself making a few
mistakes along the way.’’

Editing Data
Nathan agrees and wants to know about correcting errors. He claims he’s not
very good at typing and has made some mistakes when entering previous information. Kyle explains that you can always edit the information entered into a
worksheet regardless of whether you’ve already pressed the Enter key or not.
Excel gives you two ways to edit data. You can either edit the formula bar
or edit data directly in the cell. For instance, let’s assume the utilities expense
number you entered in cell B25 was 45251.09 when it should have been
45251.90. Also assume that the prepaid expenses entered in cell B9 was
15624.26 when it should have been 15625.45.

To edit data in the worksheet:
1 Click once in cell B25.
2 Double-click the value you entered into the cell. Note that this opens up
the cell for editing.
3 Double-click the value again and the entire value is selected.
4 Type 45251.90 and the press the [Enter] key.
5 Click once in cell B9.
6 Double-click the value you entered into the cell. Note that this opens up
the cell for editing.
7 Double-click the value again and the entire value is selected.
8 Type 15625.45 and the press the [Enter] key.
9 Since you actually did enter in the correct values you should undo your
changes. Click the Undo button from the Quick Access Toolbar two
times.
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Meagan says she will probably have to use this procedure often because her
keyboarding skills are rather weak. Fortunately, it is easy to use this process for
correcting errors and making changes to a worksheet.

Controlling the Appearance of Data
You ask Kyle why the numbers on the trial balance are formatted with commas,
since you didn’t type commas when you entered the values. He explains that
initially he formatted both columns B and C to be in the ‘‘comma’’ format. Formatting does not change the text or numbers in the cell itself; rather, it changes
the way the text or numbers appear in the worksheet. To experiment, he suggests you modify the format of cells B6, C13, B26, and C26 to a ‘‘currency’’
format, since the top and bottom of a column of accounting numbers are usually
formatted with the $. He further suggests that you replace the format with a
‘‘comma and cents’’ format using the format painter.

To apply the currency format to specific cells:
1 Click cell B6, then click the Accounting Number Format tool (it
looks like a $) on the Number group in the Ribbon. Note how the number still has the comma and cents formatting from before but now contains the $.
2 With cell B6 still selected, click the Format Painter tool (it looks like
a paintbrush) on the Clipboard group. Note that cell B6 now has ants
dancing around the border of the cell and that the mouse pointer has an
added paintbrush. Your screen should look like Figure 2.3.

Figure 2.3
Using the Format
Painter Tool

3 Click cell C13. You have now painted the Accounting Number Format
to that cell.
4 Click cell C13 and then click the Format Painter tool again.
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5 Click in cell B26 and, with the mouse button still down, drag it to the
right to include cell C26; then release the mouse button. You have now
painted the Accounting Number Format to cells B26 and C26, which
will soon contain the total of each column.

Kyle also explains that it is common practice to total the debit and credit columns of a trial balance and include a double underline under such totals.
Because you are in the midst of formatting cells, he suggests you format the
two ‘‘total’’ cells before you create a formula adding a column of cells.

To format the ‘‘total’’ cells with a double underline:
1 Click and highlight cells B26 and C26 by clicking first in B26 and then
dragging the mouse to C26 while holding down the mouse button.
2 Place the mouse pointer over the Borders tool located on the Font
group—specifically, over the small arrow located on the right of the
Borders tool. Click the arrow to reveal several border options as shown
in Figure 2.4

Figure 2.4
Selecting a Border

3 Click the Top and Double Bottom Border tool to format the cells.
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To finish the trial balance, all you need now is a total for each column.

Entering Formulas and Using Functions
Formulas in Excel always begin with an equal sign (=). These formulas can use
numbers; math symbols to add, subtract, multiply, or divide (+, , *, /); cell
references; and/or functions. Nathan asks if Excel has a calculator built in so
one could add the column and then put the result in the total cell. Kyle explains
that the disadvantage of such an approach is that, if your numbers later change,
then you’d have to re-add the column. Meagan asks if the best way to add a
column of numbers is therefore to add each cell. Kyle explains you could certainly do that by typing a formula like this: =B6+B7+B8 et cetera.
However, Kyle explains that Excel includes some functions that accomplish
this task in a more efficient manner. The SUM function, for instance, will sum
up specified series of cells.
‘‘Hold on,’’ you say. ‘‘Functions sound like programming and I’m just an
accounting student who has no desire to learn computer programming.’’
‘‘Don’t panic!’’ Kyle advises. ‘‘Excel’s functions are fairly simple. Each
function reacts to certain arguments you provide. For instance, the SUM function is written as follows: =SUM(argument). The argument is a series of cell
references you want summed. Let me show you how to add the sum function to
your trial balance to add up the debit and credit columns.’’

To use the SUM function to add a column of numbers:
1 Click cell B26.
2 Type =SUM(B6:B25), then press [Enter]. The result of that function
should be the amount $2,095,697.75.
3 Click cell C26.
4 Alternatively, you can enter the argument by clicking and dragging the
mouse pointer over the cells to be added. Click the AutoSum button in
the Editing group of the Home tab. Your screen should look like Figure
2.5 just before you click the AutoSum button.
5 Dancing ants should now be marching around the cells C15 to C25, as
shown in Figure 2.5.
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Figure 2.5
Using AutoSum

6 Click the upper right handle and, with the mouse button down, drag the
ants up until you reach cell C6.
7 Release the mouse button and press the [Enter] key.
8 Click the File menu and then click Save As. (This is done to keep your
original student file available in case you need it again and also to provide a unique name for your file.)
9 Add your name to the file name using the underscore key as you
have done previously. In this example, the file will be saved as
ch2-01_student_name (again, replace student_name with your name).
Be sure to save your file to a location (e.g., a USB drive) from which
you can later retrieve it.

Copyright 2014 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s). Editorial review has
deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.

32

Part 1

Excel for Accounting

Kyle explains that now you’ve used two different methods of entering a sum
function to add up both the debit and credit columns. In both cases, the resulting formula is the same; you’ve simply used different methods to achieve the
same goal. Moreover, if you enter different data in the cells B6 to B25 or C6 to
C25, the SUM function will automatically add them up.

More Extensive Use of Formulas
Nathan comments that he envisions another use of this worksheet software.
Weekly he prepares, by hand, a ‘‘Badfish SUPs sales’’ worksheet that identifies
how many Badfish SUPs have been sold each week as well as their cost,
markup, sales price, discount, and total sales. Kyle suggests that this might be a
good opportunity to illustrate a more extensive use of formulas in Excel.

Entering and Editing Formulas
Formulas in Excel always begin with an equal sign (=). As explained earlier in
this chapter, these formulas can use numbers; math symbols to add, subtract,
multiply, or divide (+, –, *, /); cell references; and/or functions.
Kyle prepares a worksheet with titles and headings that are similar to
Nathan’s hand-prepared worksheet. In it he includes the names of the four types
of Badfish SUPs sold that week, the cost or price What SUP paid for each
SUP, the usual markup on cost used to determine the price, the discount offered
that week on each SUP, and the quantity of each SUP sold. Kyle then recommends that you, Nathan, and Meagan use this form to prepare a weekly Badfish
SUP Sales worksheet for the week of November 15, 2015.
The price for each SUP is based on the SUP cost and markup percentage.
For example, if a SUP costs $100 and the markup is 50 percent, then What
SUP sells the SUP for $150 (the $100 cost plus a markup of 50 percent 
$100, or $50).
The total column is the product of the price less discount times the number
of SUPs sold. For example, if the price (as previously determined) was $150
but that week it was discounted 10 percent, then the net price would be $135
(the selling price of $150 minus the $15 discount). If five SUPs were sold, the
total would then be $675 (5  $135).
Kyle offers to walk you through the creation of formulas, the use of references, and (later) manipulating the data.

To enter and edit formulas for the Weekly Badfish SUP Sales
worksheet:
1 Open ch2-02 to reveal a file that should look like Figure 2.6.
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Figure 2.6
Badfish SUP Sales

2 Click in cell D6, where you will place the formula to calculate
price.
3 Remember, the formula for determining price is cost plus markup;
hence you must enter a formula that computes the markup and then
adds it to the cost. Type the formula = B6+(B6*C6) into cell D6
and then press [Enter]. Note that B6 is the location of the cost and
C6 is the location of the markup percentage. Note also that the cell
has been preformatted so that two decimal places are always
shown.
4 Click in cell G6, where you will place the formula to calculate the total
sales of the River Surfer 60 1100 .
5 Recall that the formula for determining total sales is price less discount times the number sold; hence, you need to enter a formula that
computes the net price and then multiplies it by the number sold.
Type the formula =(D6–(D6*E6))*F6 into cell G6, then press
[Enter]. Note that D6 is the location of the price, E6 is the location
of the discount percentage, and F6 is the location of the number sold.
Note also that the cell has been preformatted so that two decimal places are always shown. Figure 2.7 shows the worksheet just before
you press [Enter].
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Figure 2.7
Entering a Formula

6 Keep this file open.

‘‘Hold on a minute,’’ Meagan says. ‘‘All of those parentheses are confusing me.’’
Kyle explains that the formula required those parentheses to specify the order
of calculation. The formula (D6–(D6*E6))*F6 requires the innermost (here,
bold) set of parentheses to be calculated first. This is the calculation of the discount (the price times the discount percentage). The outermost set of parentheses in the formula (D6–(D6*E6))*F6 is acted on next. This is the calculation of
the discounted price (price less discount). Finally, the formula multiplies the
newly calculated discounted price by the number sold to yield the total.
‘‘Do we now have to type additional formulas for the other Badfish SUP?’’
you ask.
‘‘Thank goodness, no,’’ Kyle replies. ‘‘Excel has an AutoFill feature that
saves you the time and effort of reentering similar formulas.’’

Manipulating Data and Structuring
Worksheets
The AutoFill feature is handy whenever you need formulas or data replicated
down or across a worksheet. Kyle mentions that understanding this feature
requires that you also understand the concept of relative and absolute
references.

Using AutoFill
In the Weekly Badfish SUP Sales worksheet, you created formulas to calculate
price and total sales for the River Surfer 60 1100 SUP. Now you want to use a
similar formula to calculate the price and total sales for the other Badfish SUP.
Kyle suggests you try the AutoFill feature yourself.
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To use the AutoFill feature:
1 Click in cell D6 on the Weekly Badfish SUP Sales worksheet.
2 Note that, when selected, the cell is outlined and a small square appears
in the lower right corner of the cell. Click and hold the mouse button
down so the mouse pointer is over that square. Then drag the frame
down to cell D9 and release the mouse button See Figure 2.8.

Figure 2.8
Filling a Formula Down a Column

3 Click in cell G6.
4 Click and hold the mouse button down so that the mouse pointer is over
the square in the lower right corner of the cell. Drag the frame down to
cell G9 and then release the mouse button. Your revised worksheet
should look like Figure 2.9.

Figure 2.9
Watch Sales with Price
and Total Values

5 Keep this file open.

‘‘I see,’’ you say. ‘‘By using the AutoFill feature we’ve copied the same
formula down the worksheet.’’
‘‘Not exactly,’’ Kyle responds. ‘‘In fact, you’ve copied a similar formula
down the worksheet, but it’s not the same.’’
Kyle suggests that this is a good time to explain the worksheet concept of
relative and absolute references.
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Using Relative and Absolute References
The formula placed in cells D7, D8, and D9 after using the AutoFill feature is
similar but not exactly like the formula you wrote in cell D6. If you look at the
resulting formula created in cell D7 and compare it to the formula in cell D6,
you will see relative referencing at work. Cell D6 contains the formula
B6+(B6*C6). Cell D7 contains the formula B7+(B7*C7). In other words, using
AutoFill changed the formula by increasing the row reference by 1, from row 6
to row 7. This will continue to occur as AutoFill moves down relative to the
original formula. Once again, looking at cell D8, you see the formula
B8+(B8*C8) and at cell D9 the formula B9+(B9*C9).
‘‘Do you always want AutoFill to change the references?’’ Nathan asks.
‘‘Not necessarily,’’ Kyle answers.
Kyle points out that relative referencing works well in this particular worksheet. An alternative scenario that would not use relative referencing is one
where the discount is some specific percentage for all sales. If you locate that
percentage in one cell, then relative referencing would not create proper formulas. He suggests you create a cell that specifies a discount percentage for that
week, clear the discount part of the worksheet, and rewrite the total formula.

To use absolute references in the worksheet:
1 Before making the following changes, click the File menu and button,
then Save As to save the Excel file.
2 Name the file ch2-02_student_name (replacing student_name with
your name as before), then click Save. You will now make changes to
the file to illustrate absolute references.
3 Type Discount % in cell A13. This is a label for the value you will
place in cell B13. Press [Tab] to move to the next cell.
4 Type 10% in cell B13, then press [Enter].
5 Select cells E6 through E9 by clicking in cell E6 and then, while
holding down the Shift key, clicking cell E9. (This selects the five
contiguous cells.) Alternatively, you could click in cell E6 and, while
holding the mouse button down, drag the mouse pointer down to
cell E9.
6 Right-click the selected cells to reveal the Shortcut menu, then click
Clear Contents as shown in Figure 2.10. This removes values and
text previously shown at E6 through E9.
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Figure 2.10
Right-Click Menu

7 Click cell E6.
8 Type a new formula =B13 in cell E6 and then press [Enter]. This
results in replacing the cell reference E6 with the cell reference B13.
9 Using AutoFill, like you did before, replicate the formula in cell E6
down to E9. This, however, causes a problem due to relative referencing: the formula in E7 now contains a reference to B14 instead of the
discount specified in B13. What we should have done is changed the
B13 reference from a relative reference to an absolute reference.
10 Change the formula at E6 to =$B$13 by placing a $ in front of the B
and the 13. The addition of the $ freezes the reference to an absolute
cell, regardless of where the cell may be copied to or automatically
filled using AutoFill. After you have edited the formula, press
[Enter].
11 Using AutoFill, replicate the modified formula in cell E6 down
through cell E9. Your worksheet should now look like Figure 2.11.
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Figure 2.11
Using Absolute
Referencing

12 Keep this file open.

‘‘So what happens if I change the discount from 10 percent to 13 percent?’’
Nathan asks. Kyle demonstrates that the new formula creates new totals as a
different discount percentage is entered into cell B13. He suggests you try some
alternative percentages to see the effects on the total column. When you are finished experimenting, return the discount to 10 percent.

Inserting and Deleting Columns and Rows
Nathan wants to know how to add a row if a different SUP is sold. He would
also like to insert a new column, which would display the discounted price.

To insert columns and rows on a worksheet:
1 Click the 8 in row 8 to select the entire row.
2 Right-click the 8 in row 8 to reveal the Shortcut menu, then click
Insert to add a new row. Figure 2.12 shows the window right before
you click Insert.
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Figure 2.12
Inserting a Row

3 After you click Insert, add the following SUP sales information to the new
row 8: product, River Surfer 80 600 ; cost, 560; markup, 100%; quantity, 4.
4 Use AutoFill to fill down the proper formulas for cells D8, E8, and G8.
5 Click the F in column F to select the entire column.
6 Right-click the F in column F to reveal the Shortcut menu, then click
Insert to insert a new column.

T r o u b l e ? Excel has an Undo command, which allows you to
reverse any number of actions you have executed on a worksheet. If
you accidentally delete the wrong column or too many columns, click
the Undo button on the Quick Access toolbar.
7 Type Net Price in cell F5, then press [Enter].
8 Type =D6(D6*E6) into cell F6, then press [Enter]
9 Format cell F6 in a comma style format.
10 Use AutoFill to fill down the formula in F6 through F10.
11 Click cell H11 and then click the AutoSum tool from the Editing
group, then press [Enter]. Note how Excel’s AutoSum feature automatically selects cells adjacent to cell H11 that it thinks contain data
you want to sum. This is a handy feature, but it doesn’t always select
the cell you want to sum. In this case it worked great!
12 To polish off your worksheet, click cell H11 again and format it with
a Top and Double Bottom Border by using the Borders tool from
the Font group.
13 Click cell A14. Format the cell to make the label bold by clicking the
Bold tool from the Font group. Your completed worksheet should
look like Figure 2.13.
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Figure 2.13
Final Badfish SUP
Sales Worksheet

14 Click the File menu and then click Save to save your work.
15 Keep this file open.

Working with Multiple Worksheets
Meagan is pleased with the results of the completed Weekly Badfish SUP Sales
worksheet, but now she would like the sales to be summarized in 4-week increments. Kyle replies that the best way to handle this would be to use multiple
worksheets. You can create a worksheet for every week and a summary sheet
for every 4-week period.
At the bottom of the worksheet in Figure 2.13, you can see the Sheet1
label. Kyle suggests you first re-label Sheet1 as November 15, indicating the
start of the week. Then he suggests you copy the November 15 worksheet
and create a November 1 worksheet, then again for November 8, and again
for November 22.

To work with multiple worksheets:
1 Double-click the tab Sheet1, change the name of the worksheet to
November 15, and then press the [Enter] key.
2 Right-click the newly labeled tab November 15 to reveal the Shortcut
menu, then click Move or Copy.
3 Check the Create a copy checkbox and then click OK in the Move
or Copy window. A new worksheet labeled November 15 (2) appears
in the workbook.
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4 Double-click the tab November 15 (2), change the name of the worksheet to November 8, and then press the [Enter] key. You now have
two identical worksheets.
5 Repeat this process two more times to create a total of four worksheets, the last two labeled November 1 and November 22. Click and
hold the tabs and then drag them left or right to place them in order.
To see all the worksheets, you may have to shrink the scroll box on
the bottom of the worksheet.
6 Place the mouse pointer just to the left of the arrow on the horizontal
scroll box. Click and drag the mouse pointer to the right until all four
weekly worksheet tabs are visible.
7 Change the title of each worksheet to reflect the new dates by editing
cell A3. Click cell A3 on the worksheet November 1 and change the
date to read November 1. Continue the same process for the last two
worksheets. Remember: to change active worksheets, click the title of
each worksheet on the bottom tabs.
8 Change the number of Badfish SUP sold for the week of November 1
(located in cells G6 to G10) to 3,2,7,1,4 respectively. Also change the
discount percentage of cell B14 to 0%.
9 Change the number of Badfish SUP sold for the week of November 8
(located in cells G6 to G10) to 4,1,8,2,5 respectively. Also change the
discount percentage of cell B14 to 5%.
10 Change the number of Badfish SUP sold for the week of November 22
(located in cells G6 to G10) to 3,6,7,4,8 respectively. Also change the
discount percentage of cell B14 to 15%.
11 You now have four worksheets with different sales information for
each period. The November 22 worksheet on your screen should look
like Figure 2.14.

Figure 2.14
Final Badfish SUP Sales Worksheet
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12 Save the updated worksheet.
13 Keep this file open.

Finally, a Summary worksheet can be created that summarizes sales from
each week. Kyle suggests you set up a new Summary worksheet using the copy
and paste features of Excel.

To set up a summary worksheet:
1 Right-click the tab November 1, and then click Insert, and then
double-click Worksheet and press [Enter].
2 Change the name of the new worksheet to Summary.
3 Click the November 1 worksheet tab.
4 Select cells A1 to A3, right-click the mouse to activate the Shortcut
menu, and click Copy to copy the worksheet title.
5 Click the Summary worksheet tab, click in cell A1, right-click the
mouse button, and click Paste to paste the worksheet title. If the picture is captured as well, click to select it and then press [Delete].
6 Click cell A3 and type Summary.
7 Resize the height of row 4 to 47 pixels.
8 Click the November 1 worksheet tab.
9 Select cells A5 to A11, right-click the mouse to activate the Shortcut
menu and click Copy to copy the product title and names.
10 Click the Summary worksheet tab, click in cell A5, right-click the
mouse button, and click Paste to paste the product title and names.
11 Resize column A to fit the product title and names (250 pixels).
12 In cells B5 to F5 type the various weekly dates: Nov 1, Nov 8,
Nov 15, Nov 22, and Total respectively.
13 Format cells B5 to F5 using the Bold, Center, and Bottom Border
tools on the Format toolbar. The resulting worksheet should look like
Figure 2.15.
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Figure 2.15
Creating a Summary
Worksheet

14 Keep this file open.

The Summary worksheet you’ve set up is now ready for weekly data. Rather
than typing the totals from each product for each week, Excel enables you to
link the Summary worksheet with the weekly worksheets.

To link the Summary worksheet to weekly worksheets:
1 Click in cell B6 of the Summary worksheet.
2 Type = into cell B6.
3 Before pressing Enter, activate the November 1 worksheet and click in
cell H6; then press [Enter]. This automatically enters the reference
‘November 1’!H6 into the Summary worksheet cell B6.
4 Use AutoFill to replicate the formula now entered in the Summary
worksheet cell B6 down the worksheet to cell B10.
5 Click in cell C6 of the Summary worksheet.
6 Type = into cell C6.
7 Before pressing Enter, activate the November 8 worksheet and click in
cell H6; then press [Enter]. This automatically enters the reference
‘November 8’!H6 into the Summary worksheet cell C6.
8 Use AutoFill to replicate the formula now entered in the Summary
worksheet cell C6 down the worksheet to cell C10.
9 Repeat this same process for November 15 and November 22.
10 Use the SUM function to total sales by product in cells F6 through
F10 on the Summary worksheet.
11 Use the SUM function to total weekly sales in cells B11 through F11.
12 Format cells B11 to F11 with a Top and Double Bottom Border.
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13 Increase the size of any column to remove the # signs found in cells.
14 Reduce the size of the horizontal scroll box to reveal all worksheet
tabs in your Badfish SUP Sales workbook. The completed summary
worksheet should look like Figure 2.16.

Figure 2.16
Completed Summary
Worksheet

15 Save your work.
16 Keep this file open.

Using Headers and Footers
Often you will create multiple versions of a worksheet and, when they are
printed, you won’t know which version is which. Thus, it’s important to include
a date and time stamp on each worksheet. Kyle indicates that Excel has a builtin function that will not only date and time-stamp your work but also indicate
the file name on each worksheet when printed. Both of these functions can be
placed in either the header or footer of a worksheet.

To use headers and footers in a worksheet:
1 Click the View tab on the Ribbon, then click Page Layout from the
Workbook Views group.
2 Click the text Click to add header, and then type &[Tab] (this will
insert the sheet name as the header when the worksheet is printed).
3 Press [Tab] to move to the right section of the header.
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4 Type &[Date] into the right header text box. (This will print the system date in the upper right corner of each worksheet; the system date
is the current date you are printing your worksheet.)
5 Press [Tab]. Your screen should look like Figure 2.17 except for the
current date, which will instead be the system date at the time you
complete this work.

Figure 2.17
Adding a Header to Your Worksheet

6 Scroll to the bottom of your worksheet.
7 Click in the center footer text box, and then type &[File] into the
footer. This &[File] will print the worksheet file name in the footer of
each worksheet.
8 Press [Tab] and note the file name (ch2-02_student_name) in the
Footer preview box.
9 Click outside the footer in any cell and then click Normal from the
Workbook Views group on the View tab of the Ribbon.
10 Keep this file open.

Printing
Printing often requires three steps: previewing the print job, editing the page
setup, and then finally printing the worksheet. Kyle suggests that, to save paper,
these three steps should always be performed.
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Using Print Preview and Page Setup
Previewing the print job will save you lots of paper and headaches, Kyle
explains. A print preview is available from the File menu. In addition to previewing the print job, the Print window also gives you the option of zooming
in on the print job, modifying margins, viewing page breaks, and printing the
job.
Page Setup establishes the worksheet’s page orientation and scaling, margin
specifications, headers and footers (which we just addressed), and ‘‘sheet’’ provisions that include print area and print titles.
The Page section is the first tab, located on the far left of the Page Setup
window. Here you can specify the page orientation (Portrait or Landscape).
Kyle prefers the terms vertical and horizontal, which more accurately communicate the direction the worksheet will be printed on a standard 8½00 by 1100 piece
of paper. If the worksheet is too big to print on just one sheet, the user can
scale the printing by a percentage of its normal size or to fit on a specific number of pages.
The Margin section is the second tab. Here you can modify the header and
footer depth as well as the top, bottom, right, and left margins. In addition, you
can specify that the worksheet be centered on the page either horizontally, vertically, both, or neither.
The Sheet section allows you to restrict printing to a certain segment of the
worksheet and to repeat titles at the top or left of the worksheet if your printing
runs more than a single page. While editing worksheets, Kyle likes to print his
work in process and take it on the road, where he doesn’t have a computer. In
this case, he prints the gridlines and row and column headings so he can write
additional formulas by hand.
Kyle decides to modify the page setup for the Summary worksheet by specifying a portrait orientation, centering the worksheet horizontally, and with gridlines and row and column headings.

To preview a print job and edit the page setup of a
worksheet:
1 Click the File menu and then click Print.
2 Select Landscape orientation option if it is not already selected (See
Figure 2.18.).
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Figure 2.18
Print Options

3 Click Page Setup from the bottom of the screen and then click the
Margins tab and then click the Horizontally checkbox on the Center
on page section.
4 Click the Sheet tab and click the Gridlines and Row and column
headings checkboxes.
5 Click the Header/Footer tab; note that your previous modifications to
the header and footer (during the page layout) have been preserved
here.
6 Click OK.
7 Click the Zoom to Page icon located in the lower right hand corner of
the screen to magnify the pending print job, then use the scroll bars to
move around your view of the print job. You screen should look like
Figure 2.19.
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Figure 2.19
Print Preview with Magnification

8 Keep this file open.

Printing a Worksheet
As already mentioned, you can print from the Print Preview window or print
directly from the worksheet. Kyle once again suggests that you always preview
your work before printing and thus that you get into the habit of printing from
the Print Preview window.
The Print Preview window allows you to select a printer (assuming more
than one printer is connected to your computer or network). In addition, you
can specify the print range (which pages to print), what you wish to print (the
entire workbook, the active sheet(s), or a specific selection you’ve already highlighted on the worksheet), and/or how many copies you want printed.
Meagan suggests you print one copy of the entire workbook with the gridlines and row and column headings specified previously as well as one copy of
the summary worksheet without gridlines and row and column headings.

To print the workbook:
1 Click the Zoom to Page icon again to reduce the print preview window.
2 Select a printer from the Printer drop-down list and then select Print
Entire Workbook from the Settings drop-down list.
3 Click Print. This should print five pages.

T r o u b l e ? You may have to modify which printer to print to in
lab situations. Please see the lab consultant or your instructor for
instructions.
4 Save your work.

Copyright 2014 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s). Editorial review has
deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.

Excel Basics

Chapter 2

49

Nathan notices that, when the workbook was printed in total, only the Summary worksheet had a header and footer. Kyle explains that this happened
because you had set up the header and footer for the Summary worksheet only;
thus, headers and footers for the remaining worksheets should not be expected.
Nathan also noticed that some worksheets printed in portrait view, and he suspects that this is due to not setting all worksheet to landscape as well.

Printing and Viewing Formulas
‘‘Is there any way to look at a worksheet and see all the formulas in the worksheet without clicking on each cell?’’ Nathan asks.
‘‘Yes,’’ Kyle replies. ‘‘You can not only view the underlying formulas, but
often you’ll want to print them for later analysis.’’
Kyle offers to demonstrate this Excel feature and advises that, whenever you
print a worksheet with formulas, you be sure to include gridlines and row and
column headings for easy reference. He suggests you print the formulas found
on the November 1 sheet.

To view and print formulas in a worksheet:
1 Click the return arrow (the arrow with a circle around it at the upper
left-hand corner of the Print window) and then click the November 1
worksheet.
2 While holding the Ctrl key down, press the [`] key (located just above
the Tab key). This reveals all cells as formulas, a feature known as the
Formula view. Observe that the columns become larger when you
press these keys.
3 While holding the Ctrl key down, press the [`] key again and the
worksheet reverts back to values (known as the Value view). Simultaneously, the columns return to their original, smaller size.
4 Switch to the Formula view once again. (While holding the Ctrl key
down, press the [`] key.)
5 Resize each column so that all formulas are viewable. (This will
require some columns to be widened and others to be narrowed.)
6 Click the File menu and then click Print. Note that printing this worksheet requires two pages, as indicated in the lower left corner of the
Print Preview window.
7 Under Settings, select Print Active Sheets and then change to
Landscape Orientation.
8 Select Fit Sheet on One Page from the last drop-down list which
should currently say No Scaling.
9 Click Page Setup and then click the Sheet tab and check the
Gridlines and Row and column headings checkboxes so that the
worksheet, when printed, can help you decipher the formulas.
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10 Click OK in the Page Setup window (note that printing now requires
only one page, as specified in the lower part of the window). Your
print Preview screen should look like Figure 2.20.

Figure 2.20
Print Preview of
Worksheet Formulas

11 Click Print in the Print Preview window.
12 Click OK in the Print window.
13 While holding the Ctrl key down, press the [`] key and so return to
Value view.
14 Resize all columns so that all values are shown.
15 Close the worksheet and save your changes.

Kyle explains that printing the Formula view is an effective way of examining your worksheet logic and correcting any errors. It also allows you to view
the formula logic when a computer is not available.
‘‘That’s a lot to grasp in one sitting,’’ you complain.
‘‘Oh there’s a lot more to come, but let’s take a break and start again tomorrow,’’ Kyle says.

End Note
The three of you are somewhat overwhelmed by the capabilities of Excel but
are pleased with what you’ve accomplished. You’ve learned some basics about
Excel’s help system, how to work with files, and how to enter information into
a worksheet, use formulas, manipulate data, structure a worksheet, and print
worksheets in both Value and Formula views.
In the next chapter, you will learn how to use Excel to create financial
statements.
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practice
1

Explain how information is entered into an Excel worksheet.

2

Identify the difference between labels and values.

3

What does it mean when a cell or cells in a worksheet include a series of
# signs?

4

Explain the process for changing column width or row height.

5

How do you control the appearance of data in a worksheet?

6

What does the Format Painter tool do?

7

How are formulas written in Excel?

8

Explain the arguments used in the SUM function.

9

Explain the importance of parentheses in formulas.

10

How does the AutoFill feature of Excel help the worksheet user?

11

Why would you want to use absolute references instead of relative
references?

12

How do you change a relative reference to an absolute reference?

13

Describe the procedure used to insert a column or row into a worksheet.

14

How do you change the name of a sheet in a workbook?

15

What is the recommended procedure for printing a workbook or worksheet?

2

Chapter 2 Assignments
1

Create a trial balance for What SUP as of March 31, 2016
You are to create a trial balance in a format identical to that created in
this chapter. Include a debit and credit column, totals for each column,
and appropriate labels and formatting. Start with blank spreadsheet and
once you have created the spreadsheet save the file as ch2-03_student_
name (replacing student_name with your name). An alphabetical listing
of account information as of March 31, 2016, follows.
Accounts payable
Accounts receivable
Accumulated depreciation: Building
Accumulated depreciation: Equipment
Advertising expense

75,182.10
90,432.41
65,000.00
11,000.00
14,265.74
51
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Building
Cash
Common stock
Cost of goods sold
Depreciation expense
Equipment
Inventory
Land
Long-term debt
Other expense
Payroll expense
Prepaid expenses
Retained earnings
Sales revenue
Supplies
Utilities expense

2

300,000.00
32,511.34
10,000.00
341,876.41
8,000.00
72,000.00
118,348.94
125,000.00
420,000.00
1,500.00
69,421.72
13,842.11
192,697.36
434,925.13
8,434.19
13,171.73

a.

Print the completed worksheet in Value view, with your name and
date printed in the lower left footer and file name in the lower right
footer.

b.

Print the completed worksheet in Formula view, retaining gridlines
and row and column headings, with your name and date printed in
the lower left footer and file name in the lower right footer.

Modify What SUP Sales Worksheet
Using the student file Ch2-04.xlsx, add appropriate formulas to the existing Fanatic SUP Sales worksheet to calculate price, total sales for each
ring for the week, and total sales for all Fanatic SUP. Complete this
worksheet in a manner consistent with the Weekly Badfish SUP Sales
worksheet completed in this chapter. Prior to entering your formulas, the
worksheet should look like Figure 2.21. Save the file as ch2-04_student_
name (replacing student_name with your name).

Figure 2.21
Partially Completed
Diamond Ring Sales
Worksheet
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a.

Print the completed worksheet in Value view, with gridlines and row
and column headings and with your name and date printed in the
lower left footer and file name in the lower right footer.

b.

Print the completed worksheet in Formula view, retaining gridlines
and row and column headings, with your name and date printed in
the lower left footer and file name in the lower right footer.
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Chapter 2 Case Problem 1:

KELLY’S BOUTIQUE
Kelly’s Boutique, located in Pewaukee, Wisconsin, sells a unique combination
of books and women’s shoes. Customers love to peruse her book inventory
while trying on the latest in shoe fashions, often buying both books and shoes
even though they came in to buy only one type of merchandise. Casey, Kelly’s
youngest son, a college student studying accounting, is home for the holidays
and can’t wait to help his mom come in from the dark ages and use computers
in her business. Throughout this text Casey will make every attempt to bring
his mom up to speed by teaching her the use of Excel and Access as they apply
to her accounting and business needs.
To begin, Casey suggests that Kelly use a worksheet to make a list of her
book inventory. She doesn’t maintain a large inventory, but she does carry
books that she thinks moms in the community might be interested in reading or
buying as gifts for their children or friends.
Start with worksheet ch2-05. Format this worksheet using bold and italics
formatting for the titles and bold and border formatting for the column names.
Add formulas for column E to compute the sales price as list price less the discount specified. Add the following two books and related information to the list.
(Be sure the list maintains its alphabetic organization by inserting rows in the
correct place.)
Dept

Children
Adult

Product

Author

List Price

Make Way for Ducklings
Snow Falling on Cedars

McClosky
Guterson

17.99
21.95

Insert a new column D with the title ‘‘On Hand’’ in bold, centered, and center justified. Change the formatting of the column to no decimals. Add the following on hand values to column D.
Product

Author

Angela’s Ashes
Betsy – Tacy
Blueberries for Sal
Caddie Woodlawn
Deep End of the Ocean
Divine Secrets of the YaYa Sisterhood
Green Eggs and Ham
Harry Potter and the Chamber of Secrets
Harry Potter and the Prisoner of Azkaban
Harry Potter and the Sorcerer’s Stone

McCourt
Lovelace
McCloskey
Brink
Mitchard
Wells
Seuss
Rowling
Rowling
Rowling

On Hand

5
2
2
1
4
3
1
4
3
2
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Product

Author

Hop on Pop
Horse Whisperer
Lentil
Make Way for Ducklings
Memoirs of a Geisha
Message in a Bottle
One Morning in Maine
Snow Falling on Cedars
The Cat in the Hat
The Notebook

Seuss
Evans
McCloskey
McCloskey
Golden
Sparks
McCloskey
Guterson
Seuss
Sparks

On Hand

1
2
2
2
4
2
1
2
1
3

Add a ‘‘Total’’ label in cell B27 and a SUM function in cell D27 to add up
the quantity of books on hand. Change the name of Sheet1 to ‘‘15% Discount.’’
Create a copy of this worksheet and place it before Sheet2. Change the name of
the newly created worksheet to ‘‘20% Discount.’’ Change the discount in cell
F1 of this worksheet to 20 %. Save the file as ch2-05_student_name (replacing
student_name with your name).
a.

Print the completed 15% Discount worksheet in Value view, with
your name and date printed in the lower left footer and file name in
the lower right footer.

b.

Print the completed 20% Discount worksheet in Value view, with
your name and date printed in the lower left footer and file name in
the lower right footer.

c.

Print the completed 15% Discount worksheet in Formula view, with
gridlines and row and column headings, landscape orientation, scaling
to fit to 1 page wide by 1 page tall, and with your name and date
printed in the lower left footer and file name in the lower right footer.

d.

Print the completed 20% Discount worksheet in Formula view, with
gridlines and row and column headings, landscape orientation, scaling
to fit to 1 page wide by 1 page tall, and with your name and date
printed in the lower left footer and file name in the lower right footer.

Chapter 2 C ase P roblem 2:

WINE DEPOT
The Wine Depot, located in Santa Barbara, California, imports and sells highquality wine from around the world. Owner Barbara Fairfield is curious to see
how Excel might help her manage the business and account for its inventory.
Her husband, Bud, is the accountant in the family but hasn’t had much experience with Excel. He’s hired you to help him construct several worksheets to
help the business better understand the financial and managerial aspects of the
company.
To begin, you decide to create a worksheet of some of Barbara’s wine inventory. Start with worksheet ch2-06. Format the company name and worksheet
title bold and italics. Format the title of each column of data bold with a bottom
border. Format all values for the column Price as Accounting Number Format.
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Add two column labels, Quantity and Value, to the right of the existing data
and then insert quantity amounts as shown below [Note: SKU (Stock Keeping
Unit) is a unique identifier for each of the distinct products and services that
can be ordered from a supplier.]:
SKU

17521
16716
16528
16739
15347
17539
11599
14539
17840
13883
15966
17454
17024
16554
17425
17549
17578
17275

Quantity

4
10
12
5
7
3
1
5
12
12
24
24
10
8
7
3
2
1

Insert a formula to calculate value as quantity times price in cell I9, then filldown this formula for all cells in the table. Insert a text label ‘‘Total’’ in cell H28
and a formula to calculate the total value in cell I28. Insert two additional rows
after row 27. Add two American Syrah wines in those two rows: Carhatt, $34
(750 ml, year 2000, SKU 16769), quantity 10; and Cafaro, $35 (750 ml, year
2000, SKU 16874), quantity 15. Delete the row containing the American Merlot
from Wildhorse. Change the formatting of the Price and Value columns to
include no decimals. After using Excel’s Help function to learn how to sort items
in a worksheet, sort the information on your worksheet by location and then by
type, in ascending order. Change the name of Sheet1 to ‘‘Pricing.’’ Create a copy
of this worksheet and place it before Sheet2, then change the name of this sheet
to ‘‘Cost.’’ Add a label at cell C4 of the Cost sheet called Cost % in Bold, Italics.
Type 60% as the cost percentage in cell D4 of the Cost sheet. Change the name
of the column ‘‘Value’’ to ‘‘Cost.’’ Create a new formula in cell I9 to calculate
cost as Price times Cost % times Quantity. (Be sure to use absolute or relative
references where appropriate.) Fill the formula in cell I9 down to all items. Save
the file as ch2-06_student_name (replacing student_name with your name).
a.

Print the completed Pricing worksheet in Value view, with portrait orientation, scaling to fit to 1 page wide by 1 page tall, and with your
name and date printed in the lower left footer and file name in the
lower right footer.

b.

Print the completed Cost worksheet in Value view, with portrait orientation, scaling to fit to 1 page wide by 1 page tall, and with your
name and date printed in the lower left footer and file name in the
lower right footer.
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c.

Print the completed Pricing worksheet in Formula view, with gridlines
and row and column headings, portrait orientation, scaling to fit to 1
page wide by 1 page tall, and with your name and date printed in the
lower left footer and file name in the lower right footer.

d.

Print the completed Cost worksheet in Formula view, with gridlines
and row and column headings, portrait orientation, scaling to fit to 1
page wide by 1 page tall, and with your name and date printed in the
lower left footer and file name in the lower right footer.

Chapter 2 C ase P roblem 3:

SNICK’S BOARD SHOP
Snick’s Board Shop is located in La Jolla, California, and specializes in complete and longboard skateboards and equipment. Owner Casey ‘‘Snick’’ Miller
is curious to see how Excel might help him manage the business and account
for its inventory. His girlfriend Caitlin handles the financial aspects of the business but hasn’t had much experience with Excel. They have hired you to help
him construct several worksheets to help the business better understand the financial and managerial aspects of the company.
To begin, you decide to create a worksheet of Snick’s inventory. Start with
worksheet ch2-07 and make the following changes:
1 Format the company name and worksheet title bold and italics.
2 Format the title of each column (located in row 5) bold with a bottom
border.
3 Format all values for the column Price as Accounting Number Format.
4 Resize column C to 250 pixels and column D to 925 pixels.
5 Use Excel’s Help feature to learn how to wrap text in a cell. Format all
cells containing data in column C and D to wrap text.
6 Add one column (titled Quantity) to the right of column Product # and
then type 10 as the quantity for all items. Add an additional column (titled Retail Value) to the right of column Quantity. Format both column
titles as all other column titles.
7 Insert a formula to calculate the retail value as quantity times price in cell
I6, then fill down this formula for all cells in the table.
8 Insert a text label ‘‘Total’’ in cell H19 and a formula to calculate the total
retail value of all products in cell I19.
9 Format cell I19 with a top and bottom double border.
10 Insert two additional rows after row 9.
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11 Add two products in rows 10 and 11 as follows.
Category

Ramp

Ramp

Manufacturer
Product Name
Description

Element
Element Launch Ramp
Blast over any and everything in
your path. 1600 tall  4600 long  19
3/400 wide. Folds to 2300 long  19
3/400 wide  600 high. Steel kick plate
for smooth transition. Rubber
capped feet to avoid slippage.
Durable, weatherproof, and powdercoated. Made from partially recycled
materials. 2 reflective Element logo
stickers for night visibility. Connects
easily to other Element Drop Spot
obstacles. Imported.
179.99
Black/Red
65-01837
5

Mojo
Mojo Wedge Ramp
Skate the unskateable or
simply pop your tricks
higher and further. 1100
tall. Imported.

Price
Style
Product #
Quantity

179.99
Black/Blue
65-00011
8

12 Change the name of Sheet1 to ‘‘Retail Value.’’
13 Create a copy of this worksheet and place it before Sheet2, then change
the name of this sheet to ‘‘Cost.’’
14 Add a label at cell F2 of the Cost sheet called Cost % in Bold, Italics.
15 Type 45% as the cost percentage in cell G2 of the Cost sheet. Change
the name of the column ‘‘Retail Value’’ to ‘‘Cost.’’ Center the Cost title.
16 Create a new formula in cell I6 to calculate cost as Price times Cost %
times Quantity. (Be sure to use absolute or relative references where
appropriate.) Fill the formula in cell I6 down to all items.
17 Save the file as ch2-07_student_name (replacing student_name with your
name).
18 Print the completed Pricing worksheet in Value view, with landscape orientation, scaling to fit to 1 page wide by 1 page tall, and with your name
and date printed in the lower left footer and file name in the lower right
footer.
19 Print the completed Cost worksheet in Value view, with landscape orientation, scaling to fit to 1 page wide by 1 page tall, and with your name
and date printed in the lower left footer and file name in the lower right
footer.
20 Print the completed Pricing worksheet in Formula view, with gridlines
and row and column headings, landscape orientation, scaling to fit to
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1 page wide by 1 page tall, and with your name and date printed in the
lower left footer and file name in the lower right footer. Resize column
D to 330 pixels and all other cells so that formulas are viewable. Don’t
save these changes.
21 Print the completed Cost worksheet in Formula view, with gridlines and
row and column headings, landscape orientation, scaling to fit to 1 page
wide by 1 page tall, and with your name and date printed in the lower
left footer and file name in the lower right footer. Resize column D to
330 pixels and all other cells so that formulas are viewable. Don’t save
these changes.

Chapter 2 C ase P roblem 4:

ROSEY’S ROSES
Rosey’s Roses is located in Savannah, Georgia, and specializes in the sale of
roses. You, as the manager of the business, are curious to see how Excel might
help you manage the business and account for its inventory. To that end, you
have hired a local college student to construct several worksheets to help the
business better understand the financial and managerial aspects of the company.
To begin, the two of you decide to create a worksheet of Rosey’s inventory.
Start with worksheet ch2-08 and make the following changes:
1 Format the company name and worksheet title bold and italics.
2 Move the company name and worksheet title from column C to column A.
3 Format the title of each column (located in row 4) bold with a bottom
border.
4 Add a column (titled Quantity) to the right of column Description.
5 Format the Quantity title aligned centered, bold with a bottom border.
6 Format the values under the Quantity title as comma style with no decimals.
7 Resize column C to 95 pixels.
8 Add an additional column (titled Cost/Unit) to the right of column Quantity.
9 Format the Cost/Unit title aligned centered, bold with a bottom border.
10 Format the values under the Cost/Unit title as currency.
11 Resize column D to 115 pixels.
12 Add an additional column (titled Cost) to the right of column Cost/Unit.
13 Format the Cost title aligned centered, bold with a bottom border.
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14 Format the values under the Cost title as currency.
15 Resize column E to 115 pixels.
16 Enter the following values for Quantity and Cost/unit
Type

Description

Shrub
Shrub
Shrub
Shrub
Shrub
Shrub
Shrub
Shrub
Climber
Climber
Tree
Tree
Tree

Abraham Darby #5
Be My Baby #5
Deja Blu #5
Koko Loko #7
Peach Drift #10
Red Drift #10
Sedona #5
Sweet Intoxication #5
Climbing Orange Crush #7
Don Juan Climber #5
Barbara Streisand 36in Tree
Firefighter 36in Tree
Trumpeter 36in Tree

Quantity

Cost/Unit

25
30
18
17
33
15
3
17
16
25
50
14
4

$39.99
$18.99
$25.99
$17.99
$12.99
$ 6.99
$14.99
$ 9.99
$32.99
$37.99
$52.99
$55.99
$65.99

17 Insert a formula to calculate the cost as quantity times cost/unit in cell E5.
18 Format this cell aligned right.
19 Fill down this formula for all cells in the table.
20 Insert a row below the last shrub listed.
21 Add one additional item into your newly added row with a type ‘‘Shrub,’’
description ‘‘Wing Ding #5,’’ quantity ‘‘30,’’ and cost/unit ‘‘11.99.’’
22 Type Total in cell A20.
23 Insert a formula to calculate the total cost of all roses into cell E20.
24 Format cell E20 to align right with a top and double bottom border.
25 Save the file as ch2-08_student_name (replacing student_name with your
name).
26 Print the completed worksheet in Value view, with portrait orientation
with your name and date printed in the lower left footer and file name in
the lower right footer.
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